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Item Writing Overview 

Item Writers write items online using ContentProducer.  Your contract will contain Item 

Specification(s) detailing the requirements of each item you are contracted to write.  Each 

Item Specification will correspond to an item template (pre-formatted Word document) in 

ContentProducer.  An overview of the basic Item Writing process is detailed below: 

  

Step 1:  Log in to Appointees Portal 

 

Step 2: Open ContentProducer from link in Appointees Portal  

 

Step 3: Copy item template into your folder 

 

Step 4: Name item 

 

Step 5: ‘Check Out’ item 

 

Step 6: Write item 

 

Step 7: ‘Check In’ item 

 

Step 8: Item Checking  

Key Contacts 

Activity Contact Telephone/e-mail 

Appointee Portal access 
and log in  

 app.portal@sqa.org.uk 
0345 213 6831 

Using ContentProducer  das.helpdesk@sqa.org.uk 
 

Graphic and Shutterstock 
queries 
 

Graphic Artists artwork.requests@sqa.org.uk  

Subject-specific queries 
 

Principal Assessor  

General support & advice Qualifications Manager 
Qualifications Officer 

 

mailto:app.portal@sqa.org.uk
mailto:artwork.requests@sqa.org.uk
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1. Getting Started  

Please ensure that your computer meets the following specification to run ContentProducer: 

HDD Storage 1GB of free space  

Operating system Operating system should be either:  

• Windows 7 

• Windows 8 

• Windows 8.1 

• Windows 10 
 

.NET Microsoft .NET Framework 2.0 (Service Pack 2) to Microsoft .NET 
Framework 4.0 

Microsoft Word version A full licenced version of: 
Microsoft Word 2007 
Microsoft Word 2010 
Microsoft Word 2013fla 
Microsoft Word 2016 
                                                                                                                                                                                                                                                                                                                                                            

Internet Browser Microsoft Edge 

Connectivity  Broadband 

Screen resolution 1280 by 1024 

 

An Apple computer with a MAC operating system must meet the specification above, and 

must have a Microsoft Windows environment for ContentProducer to run. This means 

that the operating system must have: 

• a licensed/legal copy of Microsoft Windows 7 (or later) installed 

• an Intel CPU (in order to run Microsoft Windows) 

• Microsoft Word 2007 or later installed onto the Microsoft Windows environment 

The simplest way of installing Microsoft Windows on a MAC is to use a product like 

VirtualBox.   This is a free application (downloadable from www.virtualbox.org) which allows 

you to create a virtual drive on your MAC which will allow Windows to be installed within the 

MAC operating system as if it was on a separate PC. 

If you would prefer to start Windows when booting up the computer then you should use 

Boot Camp as provided by Apple.  Instructions on installing and setting this up can be 

accessed from https://www.apple.com/uk/support/ 

 

  

http://www.virtualbox.org/
https://www.apple.com/uk/support/
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2. Log In – Appointees Portal  

The Appointees Portal is a secure online portal that allows you to view and maintain your 
personal details and is also where you will access ContentProducer.  

To access the Appointees Portal please use the url below:  

https://appointees.sqa.org.uk 
 
► Enter your email address and password and click Login: 

 

► Click on the link to ‘Content Producer’ to open the ContentProducer homepage: 

 

Note:  the first time you click on this link you will be asked to install the ContentProducer 

application.      

https://appointees.sqa.org.uk/
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3. ContentProducer – Homepage  

Your homepage will look like this: 

 

Your My Contracts table shows how many of each item you have been contracted to write, 

and how many you have still to create.   

When you have finished writing an item, the Checkers can start their work and the figures in 

your My Contracts table will change. 

►Select your project from the drop down menu and click Open Project 
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You will see the project title appear on the right hand side, in the view known as Solution 

Explorer: 

 

  

Project title 

appears here 
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4. Folders and Filters 

► Click on ‘+’ and ‘-’ to expand or collapse any folder:  

 

You can also view items using the filters: 

 

For example, if you want to see all items at Draft status, select the Draft filter: 

 

Note: 

If you filter on Ready for Checking, there will be no results.  This is because the Ready for 

Checking filter is only available to Checkers.   

If you have a contract as a Writer and a Checker, you can select the ‘Check’ tab and you will 

be able to filter on Ready for Checking and see all items you have been contracted to check 

at this status, (you won’t see any you have written yourself).  

Folder containing item template(s) for all Item 

Specifications in your subject area/level 

Folder for each 

Writer  

Draft filter selected 

Shows items at 

Draft and separated 

by Writer 
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5. Copy a Template 

Before you can start writing an item, you need to copy the appropriate item template into 

your folder.   

► Click ‘+’ beside the Item Templates folder to display the contents: 

 

 

► Right click on an item template and select Copy: 

 

 

► Right click on your own folder* and select Paste: 

 

* If you do not have your own folder already set up then right click on the project title and 

select Add Folder, type your name, then click OK. 
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You will be presented with the following message (if appropriate): 

 

 

► Click Yes if appropriate  

► Click ‘+’ beside your folder and you will see that a copy of the item template is now in your 

folder: 
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6.  Name an Item 

Before you add content to an item you must give it a unique name.    

► Click on the item name once, or right click on the item and select Rename: 

 

 

► Type in the unique item name 

 

You should use the Item Specification Number as the basis for your item name 

followed by your initials.   

For example, if you are writing 2 x Item Spec 6, the unique name for each item will be: 

Item 6.1 HW 

Item 6.2 HW 

  

Initials 
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7.  ‘Check Out’ an Item  
 
ContentProducer is based on the principle of ‘checking in and out’ items.  If an item is 

‘checked in’ it means it is available to be edited/reviewed. If an item is ‘checked out’ it means 

that someone is working on it.  An item can only be ‘checked out’ by one person at a time. 

 

Note:  If you double-click on an item, instead of ‘checking it out’, you will open a 

READ ONLY VERSION of the item and any changes you make to it will NOT be saved. 

It is therefore important to ALWAYS Check Out an item that you are working on. 

► To begin working on an item, right click on it and select Check Out.   

 

 
Word will automatically open on your computer displaying the item template and the marking 

scheme template (if applicable) ready for you to start writing. For example:   

Item template 
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Marking scheme template 

  

 

Note:  When an item and marking scheme (if applicable) are checked out by you, a green 

tick will appear beside them: 
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8.  Use a Template  
  
Most item and marking scheme templates have been set up as tables within Word with 

gridlines appearing (as per the screenshots on pages 12 and 13).  If you are unable to see 

the gridlines try the following steps: 

 

Word 2010 & 2007       

Select Design – Borders – View Gridlines       

 

 

 

 

 

By viewing the gridlines you will be able to see clearly where to enter text. 

 

General Instructions  

1. Add text and the number of marks to your question(s) where indicated.  You must use 

the font and size of text already set up in the template.  You can however change the 

style of text to bold, italics etc. depending on the emphasis required within the question. 

 

2. You can add/remove rows if necessary by highlighting a row, right clicking and selecting 

either Insert Row or Delete Row. 

 

 

 

  

 



 15 

3. To amend the number of answer lines in an item template, highlight an answer line, then 

right click and select either Insert Rows Above/Below or Delete Rows: 

 
 

4. You should use the columns set up in the templates.  Do not add/remove any columns 

(as this will affect the layout of the Question Paper and final marking scheme). 

 

5. When you have finished working on an item/marking scheme select File → Save or use 

the Save icon on each document: 

 

Then click the Close icon in the right-hand corner: 

 

 
 
Note: If you select Save and see a box like this, it means that you have a READ ONLY 
version of the document open and you will not be able to save any changes.  
 

   

► Click Cancel and Close the 

Word document. 

► Right click on the item you 

want to work on and select Check 

Out (see page 12). 
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9.  ‘Check In’ an Item  

When you have finished writing an item, i.e. you have completed the question(s) and 

marking scheme (if applicable) you must ‘check in’ the item.  Before you ‘check in’, make 

sure you have saved all Word documents and closed Word.   

If you do not ‘check in’ the item, the item will become locked and unavailable to others.  

► Right click on the item and select Check In:  

 

You will be presented with the following screen:  

 

► Click on the drop-down menu under Workflow and select an appropriate status  

Status When to select this 

Draft If you have not finished writing the item and want to work on it 
again later 
 

Ready for Check When you are finished writing the item and marking scheme, 
and they are ready to be checked by the Checkers 
 
Note: when you select this status you will no longer be able 
to check out the item to make any changes. 

Graphic Required When the item contains a graphic  
 

Graphic Amendment 
Required 

When an item has been checked in as ‘Graphic Produced’ but 
now requires further changes  

 

► Click OK.   
 
At this point, the item and the marking scheme (if applicable) are ‘checked in’. 
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Note: If you select Ready for Check, you will be asked to select the Item Specification 
number from the next drop down menu  
 

 
 
 
► Select the correct Item Specification number and click OK 
 
The item and marking scheme (if applicable) are now checked in and your My Contracts 
table will update. For example, here is your My Contracts table after you have selected 
‘Ready for Check’ for one item: 
 

 
 
 
 
 
 
 

 

Still to Create has 

decreased by 1  

Currently being 

checked has increased 

by 1  
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10.  Refer an Item to the Principal 

Assessor  

If you require some guidance during your item writing you can refer your item to the Principal 

Assessor. 

To refer an item to the Principal Assessor, the item must be checked out. 

► Right click on the item and select Check Out: 

 

To write a comment for the Principal Assessor, click the point in the item where you wish to 

add the comment then: 

Word 2010 & 2007      

Select Review – New Comment:     

 
 

 

 

► Type in your comment: 
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► Save via the File menu (or use the Save icon) then click on the Close icon: 

 

 

► If the item has a marking scheme, save and close the marking scheme 

► Right click on the item and select Refer to PA 

 

You will be presented with the following message: 

 

► Click OK 

► Now right click on the item and select Check In: 

 

► Click OK  
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Your item is now ‘checked in’ and has been referred to the Principal Assessor.   

Note:  If you hover over the item, you will see that the item is Escalated.  This confirms that 

the item has been successfully referred to the Principal Assessor: 

 

 

 

 

E-mail Alerts to/from the Principal Assessor 

When an item is referred to the Principal Assessor, they will receive an e-mail indicating 

which item you would like them to look at.  The PA will add comments to the item and you 

will be notified by e-mail when the item has changed to ‘Not Escalated’ and is available for 

you to ‘check out’ and proceed with your writing.  
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11.  Add Graphics to an Item 

Graphics include illustrations, photographs, line graphs, bar charts, pie charts, diagrams, 

logos etc.  Graphics will be black and white by default. Colour can only be used where it is 

integral to the Question Paper (e.g. Art and Design, Design and Manufacture). 

The two main places you can source graphics from are Shutterstock and SQA in-house 

artists. 

Shutterstock     

You should initially search for graphics using www.shutterstock.com. 

Use the Search field (1) in the same way you would search Google (e.g. by typing ‘dog’). 

You can narrow your search by selecting ‘photos’, ‘illustrations’ or ‘vectors’ in the All Images 

bar (2) 

 

Once you have clicked the search icon you will be able to view a range of images: 

 

http://www.shutterstock.com/
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► Click on the image you would like to use to open the image web page 

► Right click on the image and select Copy (or Copy Image) 

When you are ready to insert the graphic, ensure the item is ‘checked out’ and then right 
click and select Paste to insert the image into your item. You may need to change the 
alignment or resize the image as appropriate. 

►You must then refer the item to the Graphic Artist to be checked by them. You do this by 
selecting ‘Graphic Required’ when you ‘check in’ the item (see page 16-17). 

 

SQA In-house Artists 

 
When a generic graphic from Shutterstock cannot meet the needs of a question, you can 
request bespoke graphs, pie charts, diagrams and illustrations from SQA.   
 
Complex bespoke graphics can take up to two weeks to be created and returned to 
Writers.  This should be taken into account when planning item writing activity. 
 
To request bespoke graphics: 

• Type ‘Instructions to artist’ into the item in red in the place where you would like the 
graphic to go along with a detailed description of what you need.   

• Include a copy of the exact graphic you require or an idea of what you are looking for. 
Please specify in your description if you need this specific image or something like this 
image.  Note: Different methods of inserting an image into an item are detailed in 
Appendix A. 

• Include your phone number in the description if you would prefer the Graphic Artist to call 
you to discuss the image 

 

If you insert (or request) any graphics in your item, remember to select ‘Graphic Required’ 

when you check in the item (see page 16-17) so the Graphic Artist can approve the graphic. 
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E-mail Alerts to/from the Graphic Artist 

When the Graphic Artist has created/reviewed the graphic, you will receive a ‘Graphic 

Produced’ e-mail indicating that the graphic is ready for you to review.  

► To find the item quickly in ContentProducer, use the ‘Graphic Produced’ filter: 

  

► Right click on the item and select Check Out 

Where you have provided an example/draft graphic the house styled graphic by the Graphic 

Artist will be provided alongside the example/draft graphic in the item 

► If the graphic meets your requirements, delete the example/draft graphic, save and 

close the item and marking scheme, right click on the item and select Check In, select 

‘Ready for Check’ from the drop-down menu, then click OK (see page 16-17) 

► If the graphic does not meet your requirements, insert further instructions to the 

Graphic Artist within the item in red, save and close the item and marking scheme, right click 

on the item and select Check In and ‘Graphic Amend Required’, then click OK (see page 16-

17) 

  

All items at this 

status are returned  

Filter on Graphic 

Produced 
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11.1 Include a Table in an Item 

► Click Insert – Table 

 

 

11.2 Add Large Files (e.g. Audio) to an Item 

► Right-click on the item name and select Add Resources: 

 

A window opens: 
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► Click the + Add file button and this will open your computer

 

The maximum file size that can added is 50MB. 

► Browse to find the file you want and select Open. 

 

 

The file will upload and then be listed on the Add Resources window (this may take a few 

minutes depending on the size of the file): 
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This process of clicking on + Add file, finding and adding files can be repeated if there are 

multiple files to be added. 

► Click on the Done button at the bottom of the window when finished. 

The item can now be checked in as usual. 

When submitting audio you must also record any relevant source/copyright information (see 

page 28). 

 
  

11.3 Insert Objects into an Item 

Another way to include material that has been sourced from another package (such as Excel 

or Adobe Reader) is to insert the contents of a file into your item:  

 
  

► Click Insert – Object 

You will then be 

presented with the 

screen shown on the 

right. 

► Click Create from 

File 

► Click Browse (to find 

e.g. an image on your 

computer) 

► Click OK 
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12.  Add Metadata to an Item 

When you have finished writing the item and mark scheme you should enter metadata 

(reference data) for the item. This information will be recorded (‘tagged’) against each item 

and used for the purposes of searching for items in the item bank. 

To edit the metadata, the item must be ‘checked out’ (it must have a green tick next to it and 

the mark scheme). 

► While the item is ‘checked out’, right click on it and select Edit References/Metadata 

 

►You will be presented with a window similar to this: 

 

 

►To edit the data, click on the name of the reference field to add/edit a value. 

 
If you are in doubt about which reference fields to complete, contact the Qualifications 

Manager/Officer or the Principal Assessor for your subject area. 
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13.  Record Source/Copyright Information 

If you insert any content or graphics into an item that you have not created yourself, you 
need to complete a source/copyright form. 
 
Note: You do not need to complete a source/copyright form if you have sourced the image 
from Shutterstock. 
 
► To complete a source/copyright form, right click on your folder and select Add New Page:   

 

You will be presented with this screen: 

 

 

 

► In the Page Name box, type in the item name that the source/copyright form corresponds 

to, followed by ‘Copyright Form’. For example, Item 6.1 HW Copyright Form 1. 

► Click to select Source Booklet  
 
► Click OK  
 
The source/copyright form will open automatically for you to complete. 
 
► Click File → Save and Close Word. 
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► Now right click on the source/copyright form and select Check In: 
 

 
 
 
► Keep the status of the source/copyright form at Draft and click OK 
 
Note:  If an item contains more than one source, you should right click on your folder to add 

another New Page and repeat the steps above.   
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14.  Exit ContentProducer  

Before exiting ContentProducer you should ensure that you have ‘checked in’ any items you 
have been working on. 
 
► Select File → Exit: 
 
 

 
 
 
If you have not ‘checked in’ an item you will receive a message similar to the example below: 
 

 
 
 
► Click Cancel and proceed to ‘check in’ the item(s) (see page 16 – 17) 
 
You will be able to tell which items are still checked out to you as they will have a green tick 
beside them. 
 
Note 1: If you select Yes your item(s) will be automatically checked in at their most recent 
status, without giving you the opportunity to change the status or add comments, and 
ContentProducer will close. 
 
Note 2: If you select No the item(s) will remain checked out to you and ContentProducer will 
close. The item will become locked and unavailable to others. 
 
Once you have exited CP, you must log out of the Appointees Portal.  
 
If you do not log out of the Appointees Portal you will see the following message when you 

next try to access CP:  
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This means that the system thinks that your account is still in use. In order to resolve this 

issue, make sure you log out of the Appointees portal and then log back in. 
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15. Item Checking and Rework 

When you move an item to ‘Ready for Check’ it will become available to the Item Checkers.  

You may be invited to attend an Item Checking meeting along with the PA and Item 

Checkers to discuss items and agree any changes required to your items.  Items and 

comments will be displayed on-screen during the meeting. 

If your item is ‘banked’ during the meeting, there is no further action required by you.  

However, in some instances you may be required to revise the item in your own time and 

resubmit it for further checking.   

An item could be returned to you for rework for the following reasons:  

Why has my item 
been returned? 

What should I do? What happens next? 

Amendments are 
required to the content  

Locate item under ‘Requires 
Rework’ filter (see page 8). 
 
‘Check out’ item, review 
comments, amend item, 
‘check in’ item and select 
‘Ready for Check’ (see 
page 12+). 

Checkers will review the item  

A graphic needs to be 
created/amended  
 

Locate item under ‘Requires 
Rework’ filter (see page 8). 
 
‘Check out’ item, review 
instructions, ‘check in’ item 
and select ‘Graphic 
Required’ or ‘Graphic 
Amendment Required’ (see 
page 12+). 
 
 
 

Graphic will be created/amended by 
SQA Graphic Artist and you will 
receive an e-mail informing you of 
when this has been done. 
 
Locate item under ‘Graphic 
Produced’ filter. 
 
Check out item, review graphic, 
‘check in’ item and select ‘Ready for 
Check’ so Checkers can review the 
item  
 

 

When amending and resubmitting an item it is important not to delete the comments that 

have been inserted by the Checkers, as these will be used as a reference point when re-

checking your revised item.   
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16.  Troubleshooting 

 
Problem 1: My project is not opening / I cannot see Solution Explorer on the right hand side  
 
Solution: Go to the View menu (top left) and from the list, click on Solution Explorer: 
 

 
 
 

 
Problem 2: I can see the project, but not my folder / not my work / not the marking scheme 
 
Solution: Use the + at the side of the project name / folder name / item name to expand the 
directory beneath it: 

   
 

 
Problem 3: Saving 
 
Solution: In order to ensure items are saving you must:  
 
1. ‘Check out’ an item.  
      Double-clicking on an item opens a read only version 
 

2. Edit one document at a time.  
 

3. Have no other documents open in Word other than the one you are editing. Note: if you 
are copying and pasting from another Word document you need to close the 'source' 
document before saving the item and closing Word 

 
4. Select ‘Save’ rather than ‘Save As’. ‘Save As’ will save the item to your own hard drive 

not into ContentProducer. 
 

5. Close Word (not just other documents) before checking in the item.  
 

6. Ensure you are connected to the internet and not working offline. 
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Appendix A – How to Insert an Image into 

an Item 

1. Copy and paste an image from a website.  

  

Note: if using images from websites, you must complete a source/copyright form (see 

page 28 – 29).  

 

2. Include a Jpeg of an image you have saved on to your computer by selecting Insert – 

Picture. 

 

Note: Jpegs can be created from an image that you have drawn on paper and scanned 

in to your computer.  They can also be created by you taking a photo of an image that 

you have drawn on paper. 

 

3. Draw an image by hand and scan it in to your computer (creating an Adobe PDF).  You 

can then select Insert – Object (see page 26) 

 

4. Make a sketch of the image you require in Word by selecting Insert – Shapes, then New 

Drawing Canvas.   

If you select the ‘scribble’ you will be able to sketch what you require: 

 

 

This will create a very basic hand-drawn image, but there is also the functionality to make 

images look more professional. 

5. Insert an image such as a diagram or flowchart using Insert – SmartArt.   

 

6. Insert a chart in Word by selecting Insert – Chart. 

Select the type of chart you want and then click OK.   

An area will appear on the right hand side of the screen for you to enter the data you 

want the chart to be based on. 
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7. Use the ‘Snipping Tool’ to capture a screen shot of the image. 

 

► Click the Start button .  

► In the search box type “Snipping Tool” 

► In the list of results click Snipping Tool:  
 

 

► Select the area of your screen that you want to capture. 

 

► In your item, right click and select Paste 
 


